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What is Covered in This Book
This book explains how to expose a database as a Web service using Artix
ESB command line tools and Artix Designer.
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Who Should Read This Book
This book is intended for Java developers using Artix ESB. It assumes that
you have a good knowledge of the following:

• General programming concepts

• General database concepts

• Structured Query Language
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How to Use This Book
This book is organized into the following chapters:

• Introducing Artix Database Services provides an overview of the Artix
database Web services.

• Building a JAX-WS DB Service on the Command Line explains how to use
the command line interface to build database services for the Artix ESB
Java Runtime.

• Building a JAX-RPC DB Service on the Command line explains how to use
the command line interface to build database services for the Artix ESB
C++ Runtime.

• Creating DB Services with Artix Designer explains how to build database
services for either runtime using the Artix Designer GUI tools.
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The Artix ESB Documentation Library
For information on the organization of the Artix ESB library, the document
conventions used, and where to find additional resources, see Using the Artix
ESB Library
[http://www.iona.com/support/docs/artix/5.1/library_intro/index.htm].
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Searching the Artix ESB Library
You can search the online documentation by using the Search box at the top
right of the documentation home page:

http://www.iona.com/support/docs

To search a particular library version, browse to the required index page, and
use the Search box at the top right, for example:

http://www.iona.com/support/docs/artix/5.1

You can also search within the PDF versions of each book. To search within
a PDF version of a book, in Adobe Acrobat, select Edit → Find, and enter
your search text.
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Additional IONA Resources
The IONA Knowledge Base [http://www.iona.com/support/kb/]
(http://www.iona.com/support/kb/) contains helpful articles written

by IONA experts about Inferno and other products.

The IONA Update Center [http://www.iona.com/support/updates/index.xml]
(http://www.iona.com/support/updates/index.xml) contains

the latest releases and patches for IONA products.

If you need help with this or any other IONA product, go to IONA Online
Support [http://www.iona.com/support/index.xml]
(http://www.iona.com/support/index.xml).

Comments, corrections, and suggestions on IONA documentation can be sent
to IONA using the Email Us button at the top of each HTML documentation
page.
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Document Conventions
Typographical conventions

This book uses the following typographical conventions:

Fixed width (Courier font) in normal text represents portions of code and literal names of items
such as classes, functions, variables, and data structures. For example, text might refer to the
javax.xml.ws.Endpoint class.

fixed width

Constant width paragraphs represent code examples or information a system displays on the
screen. For example:

import java.util.logging.Logger;

Fixed width italic words or characters in code and commands represent variable values you
must supply, such as arguments to commands or path names for your particular system. For
example:

Fixed width

italic

% cd /users/YourUserName

Italic words in normal text represent emphasis and introduce new terms.Italic

Bold words in normal text represent graphical user interface components such as menu
commands and dialog boxes. For example: the User Preferences dialog.

Bold

Keying conventions
This book uses the following keying conventions:

When a command’s format is the same for multiple platforms, the command prompt is not
shown.

No prompt

A percent sign represents the UNIX command shell prompt for a command that does not require
root privileges.

%

A number sign represents the UNIX command shell prompt for a command that requires root
privileges.

#

The notation > represents the MS-DOS or Windows command prompt.>

Horizontal or vertical ellipses in format and syntax descriptions indicate that material has been
eliminated to simplify a discussion.

...

Brackets enclose optional items in format and syntax descriptions.[ ]

Braces enclose a list from which you must choose an item in format and syntax descriptions.{ }
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In format and syntax descriptions, a vertical bar separates items in a list of choices enclosed
in {} (braces).

|

Admonition conventions
This book uses the following conventions for admonitions:

Notes display information that may be useful, but not critical.

Tips provide hints about completing a task or using a tool. They may also provide information about
workarounds to possible problems.

Important notes display information that is critical to the task at hand.

Cautions display information about likely errors that can be encountered. These errors are unlikely to cause
damage to your data or your systems.

Warnings display information about errors that may cause damage to your systems. Possible damage from
these errors include system failures and loss of data.
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Introducing Artix Database Services
Summary

This chapter provides an overview of how to expose a database as a Web
service using Artix ESB.

Table of Contents
Exposing a Database as a Web Service ........................................................................................ 22
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Exposing a Database as a Web Service
Overview

In a database Web service, the WSDL operations are implemented by SQL
queries and stored procedures defined in the database. You can generate a
database Web service in either JAX-RPC using the Artix ESB C++ Runtime
or in JAX-WS using the Artix ESB Java Runtime. You can define the service
using either the Artix command line tools or Artix Designer.

Supported DBMSs
You can use Artix to expose the following database management systems as
Web services:

• MySQL 4.0 and higher

• Oracle8i 8.1.7 and higher

• Sybase 12.5 and higher

• Microsoft SQL Server 2000 or higher

Database configuration files
The starting point of any Artix database Web service is the DB service
configuration file. This file is in XML format and takes the extension .xml.db.

You can create the DB config file by hand or you can generate it using Artix
Designer. If you are using the Artix ESB Java Runtime, you can also generate
the file using the artix sql2dbconfig command.

Note
The DB config files used with the Java and the C++ runtimes are
based on different schemas and are not compatible.
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Building a JAX-WS DB Service on the
Command Line

Summary

This chapter explains how to create a database service for the Artix ESB
Java Runtime using the command line interface.

Table of Contents
Creating a DB Config File ......................................................................................................... 24
Generating a WSDL File .......................................................................................................... 30
Generating JAX-WS Database Service Code .................................................................................. 32
Customizing JDBC Type Mappings ............................................................................................. 35

23



Creating a DB Config File
Overview

The database configuration file is the starting point of any Artix database
service. It contains details of the database connection that you wish to expose
as a Web service and it is where you can map SQL queries to WSDL
operations.

JAX-WS DB config file format
You can find the schema for the DB config file in the
ArtixInstallDir\java\lib\t-soa-dbservice-api-dbconfig-version.jar

library.

Example 1, “JAX-WS DB Config File” shows the format of a complete DB
config file for use with the Artix ESB Java Runtime.

Example 1. JAX-WS DB Config File
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<DbServiceDescription

xmlns="http://schemas.iona.com/dbservice/config">
<Connection>
<DriverClass>org.apache.derby.jdbc.EmbeddedDriver</DriverClass>
<ConnectionUrl>jdbc:derby:derbyDB</ConnectionUrl>
<Properties value="user1" name="password"/>
<Properties value="user1" name="user"/>
<ConnectionPool enabled="false"/>

</Connection>
<Operations name="myQuery">
<Sql query="select * from emp where ename = ?" isStoredProcedure="false"/>
<Parameters position="1" jdbcType="12" isNullable="true" direction="IN"/>
<Results type="RESULT_SET" position="1">
<Columns jdbcType="2" isNullable="true" columnName="EMPNO"/>
<Columns jdbcType="12" isNullable="true" columnName="ENAME"/>
<Columns jdbcType="12" isNullable="true" columnName="JOB"/>
<Columns jdbcType="2" isNullable="true" columnName="MGR"/>
<Columns jdbcType="91" isNullable="true" columnName="HIREDATE"/>
<Columns jdbcType="2" isNullable="true" columnName="SAL"/>
<Columns jdbcType="2" isNullable="true" columnName="COMM"/>
<Columns jdbcType="2" isNullable="true" columnName="DEPTNO"/>

</Results>

24

Creating a DB Config File



</Operations>
</DbServiceDescription>>

Generating a DB config file
When creating a database Web service for the Artix ESB Java Runtime, you
do not need to build the DB config file from scratch. You can generate it in
the correct format using the artix sql2dbconfig command.

sql2dbconfig syntax
The syntax of the artix sql2dbconfig command is as follows:

artix sql2dbconfig [ -d output-dir ] [ -new [ -driver

driver-class ] [ -connectionurl connection-url ] [ -property

property ...] [ -pool ] [ -maxactive pool-maxactive ] [ -maxidle

pool-maxidle ] [ -transaction transaction-level ] [

-autocommit { true | false } ] [ -readonly { true | false } ] ] [ -test

] [ -add [ -name name ] [ -query query ] [ -isprocedure ] [

-isupdate ] [ -oktoexecute ] [ -parametertype parameter-type

...] [ -parameterdirection parameter-direction ...] [

-parameternullable parameter-nullable ...] [ -parametervalue

parameter-value ...] [ -timeout timeout ] ] [ -delete [ -name

name ] ] [-v] [[-verbose] | [-quiet]] { outfile }

Required argument
The artix sql2dbconfig command takes one required argument: outfile

specifies the path and the name of the generated database service
configuration file. The default is ./dbconfig.xml.db.

Optional arguments
The artix sql2dbconfig command takes the following optional arguments:

InterpretationOption

Specifies the directory into which the generated
configuration file is placed.

-d output-directory

Specifies that a new configuration file is to be
generated. Only connection information will be

-new

added to the newly created configuration file.
You can add operations to the configuration file
in subsequent commands by specifying the
-add option. The target output file should not

25
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InterpretationOption

exist in the filesystem. The following options can
be used with the new option:

• -driver

• -connectionurl

• -property

• -pool

• -maxactive

• -maxidle

• -transaction

• -autocommit

• -readonly

Specifies the driver class for the new connection.
This option can only be used with -new.

-driver driver-class

Specifies the connection url for the new
connection. This option can only be used with
-new.

-connectionurl

connection-url

Specifies a connection property for the new
connection. This option can only be used with
-new.

-property property

Specifies that connection pooling should be
enabled. This option can only be used with
-new.

-pool

Specifies the maximum active connections in
the connection pool. This option can only be
used when both -new and -pool are specified.

-maxactive

pool-maxactive
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InterpretationOption

Specifies the maximum idle connections in the
pool. This option can only be used when both
-new and -pool are specified.

-maxidle

pool-maxidle

Specifies the transaction isolation level for the
new connection. This option can only be used

-transaction

transaction-level
with -new. The value should be an integer value

as defined in JDBC specification or one of the
following: none, read_committed,

read_uncommitted, repeatable_read,

and serializable.

Specifies the auto commit value for the
connection. This option can only be used with
-new.

-autocommit { true |

false }

Specifies the read only value for the connection.
This option can only be used with -new.

-readonly { true | false

}

Test a connection using the connection
information provided in an configuration.

-test

Specified when adding a new operation to an
existing database service configuration. This

-add

option cannot be used with -new. The following

options can be used with -add:

• -name

• -query

• -isprocedure

• -isupdate

• -oktoexecute

• -parametertype

• -parameterdirection
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InterpretationOption

• -parameternullable

• -parametervalue

• -timeout

Specifies the name of the operation.-name name

Specifies the query or procedure call of the
operation.

-query query

Specifies that the operation is a stored
procedure.

-isprocedure

Specifies that the operation will write to the
database. If both -isupdate and

-isupdate

-isprocedure are specified, -oktoexecute

must be specified. If the operation requires
IN/INOUT parameters, users must provide
parameter values for executing the operation.
The reason is that a stored procedure can return
multiple results. The command needs to execute
the stored procedure to obtain the result
metadata. However, if only -isupdate is

specified, the command does not need to
execute the operation and the result is assumed
to be an update count.

Specifies that it is OK to execute the operation
to get resultset metadata.

-oktoexecute

Specifies the JDBC type for a parameter by
position. Positions start at 1. The value should

-parametertype

parameter-type
be the integer or string value of the JDBC type
as defined in the JDBC specification.

For example -parametertype 1=3 specifies

that the first parameter is a JDBC decimal.

Specifies the direction for a parameter by
position. Positions start at 1. The value should
be one of IN, INOUT, and OUT.

-parameterdirection

parameter-direction
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InterpretationOption

For example, -parameterdirection 2=IN

specifies that the second parameter is an input
parameter.

Specifies whether a parameter is nullable by
position. Positions start at 1.

-parameternullable

parameter-nullable

For example, -parameternullable 1=true

specifies that the first parameter can be null.

Specifies a parameter's value by position.
Positions start at 1. This option is necessary for

-parametervalue

parameter-value
parameterized operation when -oktoexecute

is used.

For example, -parametervalue 1=12.0

specifies the first parameter's value is 12.0.

Specifies the number of seconds before the
operation times out.

-timeout timeout

Specifies that an operation is to be deleted from
the database service configuration file.

-delete

Specifies the name of the operation to delete.-name name

Displays the version number for the tool.-v

Displays comments during the generation.-verbose

Suppresses comments during the generation.-quiet
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Generating a WSDL File
Overview

You can generate the WSDL file that forms the basis of your database Web
service by running the artix dbconfig2wsdl command.

dbconfig2wsdl syntax
The syntax of the artix dbconfig2wsdl command is as follows:

artix dbconfig2wsdl [-a address] [-d output-dir] [-servicename

service-name] [-jdbctypemappings jdbc-type-mapping-file] [-mp

{ element | type }] [-t target-namespace] [-o output-file] [-logical]

[-v] [[-verbose] | [-quiet]] { dbconfigurl }

Required argument
The artix dbconfig2wsdl command takes one required argument:
dbconfigurl specifies the URL of the configuration file.

Optional arguments
The artix dbconfig2wsdl command takes the following optional arguments:

InterpretationOption

Specifies the value of generated
soap:address element's location

attribute.

-a address

Specifies the folder into which the generated
WSDL is placed.

-d output-dir

Specifies the value of the generated
service element's name attribute. The

default is DataService.

-servicename name

Specifies the name of the file containing the
mappings between JDBC types and XSD

-jdbctypemappings

jdbc-type-mapping-file
types. See Customizing JDBC Type
Mappings for details.

Specifies if the generated message parts
should be types or elements. The default is
elements.

-mp { element | type }

Specifies the target namespace for the
generated contract.

-t target-namespace
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InterpretationOption

Specifies the name of the generated WSDL
document.

-o output-file

Specifies the tool only generates the logical
portion of the WSDL document.

-logical

Displays the version number for the tool.-v

Displays comments during the code
generation process.

-verbose

Suppresses comments during the code
generation process.

-quiet
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Generating JAX-WS Database Service Code
Overview

You use the artix wsdl2dbservice command to generate the code for an Artix
ESB Java Runtime database service.

wsdl2dbservice syntax
The syntax of the artix wsdl2dbservice command is as follows:

artix wsdl2dbservice [-jdbctypemappings

jdbc-type-mapping-file] [-db data binding name...] [-wv wsdl

version...] [-p [wsdl namespace=]Package Name...] [-sn [wsdl

namespace=]Package Name] [-b binding-name...] [-d

output-directory] [-compile] [-classdir

compile-classes-directory] [-impl] [-server] [-client] [-all] [-ant]

[-nexclude schema namespace [=java packagename]...] [-exsh { true

| false }] [-dns { true | false }] [-dex { true | false }] [-validate] [-wsdlLocation
wsdlLocation attribute] [-v] [[-verbose] | [-quiet]] { wsdlurl }

Required argument
The artix wsdl2dbservice command takes one required argument: wsdlurl

specifies the WSDL file from which the database service is generated.

Optional arguments
The artix wsdl2dbservice command takes the following optional arguments:

InterpretationOption

Specifies the location of the JDBC to
XSD mapping file. See Customizing
JDBC Type Mappings for details.

-jdbctypemappings

jdbc-type-mapping-file

Specifies the data binding to use. The
default is JAXB.

-db data binding name

Specifies the WSDL version to use. The
default is WSDL 1.1.

-wv wsdl version

Specifies the Java package name to use
for the generated code. Optionally, you

-p [wsdl namespace=]

Package Name
can specify the WSDL namespace
mapping to a particular Java package
name.

32

Generating JAX-WS Database Service
Code



InterpretationOption

Specifies the service name to use for
the generated code. Optionally, you can
specify the WSDL namespace.

-sn [wsdl namespace=]

Package Name

Specifies an external JAXWS or JAXB
binding files.

-b binding-name

Specifies the directory into which the
generated code is placed.

-d output-directory

Specifies that the generated code is
compiled.

-compile

Specifies the directory into which the
compiled class files are placed.

-classdir

compile-classes-directory

Generates a dummy implementation
class.

-impl

Generates a server mainline for the
service.

-server

Generates the code needed to deploy a
client.

-client

Generates all starting point code: types,
service proxy, service interface, server

-all

mainline, client mainline,
implementation object, and an Ant
build.xml file.

Generates an Ant build.xml.-ant

Ignore the specified WSDL schema
namespace when generating code. This

-nexclude schema-namespace

[=java-packagename]
option may be specified multiple times.
Also, optionally specifies the Java
package name used by types described
in the excluded namespace(s).

Enables or disables processing of
extended soap header message binding.

-exsh { true | false }

Enables or disables the loading of the
default namespace package name
mapping. Default is true.

-dns { true | false }
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InterpretationOption

Enables or disables the loading of the
default excludes namespace mapping.
Default is true.

-dex { true | false }

Enables validating the WSDL before
generating the code.

-validate

Displays the tool's version.-v

Specifies that the tool surpresses most
messages.

-quiet

Specifies that the tool displays verbose
messages.

-verbose
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Customizing JDBC Type Mappings
Overview

The mappings from JDBC types to the XML Schema types used in a Web
service are controlled by a JdbcTypeMapping.xml file in the

ArtixInstallDir/java/lib/it-soa-dbservice-rt-typemappers-version.jar

library. Normally, there is no need to alter these mappings. However, where
you are working with an unsupported database, you can customize them by
creating a custom JdbcTypeMapping.xml.

Default mappings
The default JDBC to XML mappings are as follows:

Table 1. Default JDBC to XSD Type Mappings

XML Schema TypeArtix Java TypeJDBC Type

stringStringCHAR

stringStringVARCHAR

stringStringLONGVARCHAR

decimaljava.math.BigDecimalNUMERIC

decimaljava.math.BigDecimalDECIMAL

booleanBooleanBIT

booleanBooleanBOOLEAN

byteIntegerTINYINT

shortIntegerSMALLINT

intIntegerINTEGER

longLongBIGINT

floatFloatREAL

doubleDoubleFLOAT

doubleDoubleDOUBLE

hexBinarybyte[]BINARY

hexBinarybyte[]VARBINARY

hexBinarybyte[]LONGVARBINARY

datejava.sql.DateDATE

timejava.sql.TimeTIME
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XML Schema TypeArtix Java TypeJDBC Type

dateTimejava.sql.TimestampTIMESTAMP

hexBinarybyte[]BLOB

stringStringCLOB

Using alternative mappings
When you run the artix dbconfig2wsdl and artix wsdl2dbservice commands,
the default JDBC to XSD mappings are used unless you use the
-jdbctypemappingsjdbc-type-mapping-file argument to point to

a customized mapping file.
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Building a JAX-RPC DB Service on the
Command line

Summary

This chapter explains how to create a JAX-RPC database service for the Artix
ESB C++ Runtime using the command line interface.

Table of Contents
Creating a DB Config File ......................................................................................................... 38
Generating WSDL and Code ..................................................................................................... 40
Generating JAX-RPC Database Service Code ................................................................................. 42
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Creating a DB Config File
Overview

The database configuration file is the starting point of any &prodnameshort;
database service. It contains details of the database connection that you wish
to expose as a Web service and it is where you can map SQL queries to WSDL
operations.

JAX-RPC DB config file format
The examples below show DB config files for use with the Artix ESB C++
Runtime.

Example 2. Basic DB Config File for Artix ESB C++ Runtime
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<db-service>
<operation name="findEmployeeByID" isStoredProcedure="false"
timeout="3000" transactionIsolocation="Read.Committed"
isReturnUpdateCount="false">
<SQL_query>SELECT * FROM employee_account WHERE ID=?</SQL_query>
<parameter jdbctype="INTEGER" name="employeeId" direction="IN"/>
<result columnName="ID" jdbctype="INTEGER"/>
<result columnName="Name" jdbctype="LONGVARCHAR"/>
<result columnName="PhoneNumber" jdbctype="INTEGER"/>
<result columnName="Birthday" jdbctype="DATE"/>
<result columnName="Salary" jdbctype="REAL"/>

</operation>
<operation name="findEmployeeCount" isStoredProcedure="false" isReturnUpdateCount="false">

<SQL_query>SELECT Count(*) FROM employee_account</SQL_query>
<result columnName="Count(*)" jdbctype="BIGINT"/>

</operation>
<operation name="updateEmployeeDetail" isStoredProcedure="false" isReturnUpdateCount="true">

<SQL_query>UPDATE employee_account SET PhoneNumber=? WHERE Name=?</SQL_query>
<parameter jdbctype="INTEGER" name="phoneNumber" direction="IN"/>
<parameter jdbctype="LONGVARCHAR" name="employeeName" direction="IN"/>

</operation>
<jdbc-connection>
<driverclass>com.mysql.jdbc.Driver</driverclass>
<connectionurl>jdbc:mysql://localhost:3306/DBSAMPLE</connectionurl>
<username>root</username>
<password/>
<maxActive>10</maxActive>
<maxIdle>5</maxIdle>

</jdbc-connection>
</db-service>
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Example 3. DB Config File including Stored Procedure
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<db-service>
<operation name="addSalary"
isStoredProcedure="true" isReturnUpdateCount="false">
<SQL_query>{Call add_salary_inout(?,?,?) }</SQL_query>
<parameter jdbctype="INTEGER" name="employeeId" direction="IN"/>
<parameter jdbctype="VARCHAR" name="na" direction="OUT"/>
<parameter jdbctype="FLOAT" name="sa" direction="INOUT"/>

</operation>
<jdbc-connection>
<driverclass>com.mysql.jdbc.Driver</driverclass>
<connectionurl>jdbc:mysql://localhost:3306/DBSAMPLE</connectionurl>
<username>root</username>
<password/>
<maxActive>10</maxActive>
<maxIdle>5</maxIdle>

</jdbc-connection>
</db-service>

Creating a DB config file
Unlike the Java runtime, there is now way to generate a DB config file for the
Artix ESB C++ Runtime. You can either create the file using a text editor,
following the examples above, or use Artix Designer to generate and edit the
file.
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Generating WSDL and Code
Overview

You use the dbconfigtowsdl command to generate a WSDL document from
an Artix ESB C++ Runtime DB config file. You can also use it to generate
code for your database service, provided you do not plan to make further
changes to the WSDL.

dbconfigtowsdl syntax
The syntax of the dbconfigtowsdl command is as follows:

dbconfigtowsdl [-a bindingAddress] [-fasttrack] [-plugin] [-p

packageName] [-d dir] [-source dir] [-h] [-ant] [-v] [[-quiet] | [-verbose]]

{ dbconfigurl }

Required arguments
The dbconfigtowsdl command takes one required argument: dbconfigurl

specifies the URL of the database configuration file.

Optional arguments
The dbconfigtowsdl command takes the following optional arguments:

InterpretationOption

Specifies the address to use in the port element of the
generated WSDL. This flag is only valid when

-t

bindingAddress
-fasttrack is also used. The default is

http://localhost:9000/DBConnection

Specifies that the tool will generate a default SOAP
binding and HTTP endpoint for the database operations.

-fasttrack

In addition, the tool will generate the code for the
intermediary required to expose the operations as a
service.

Specifies that the intermediary is generated as an Artix
ESB C++ Runtime plug-in. This flag is only valid when
-fastttrack is also used.

-plugin

Specifies the Java package name to use for the genrated
code.

-p packageName

Specifies the output directory for the generated WSDL
file. The default is the local directory. When
-fasttrack is used, the default is etc.

-d dir
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InterpretationOption

Specifies the output directory for the generated code.
This flag is only valid when -fasttrack is also used.

The default is java.

-source dir

Displays the tool's usage statement.-h

Displays the version number for the tool.-v

Displays comments during the code generation process.-verbose

Suppresses comments during the code generation
process.

-quiet
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Generating JAX-RPC Database Service Code
Overview

You use the wsdltodbservice command to generate JAX-RPC compliant Java
code from a WSDL file and database configuration file.

wsdltodbservice syntax
The syntax of the wsdltodbservice command is as follows:

wsdltodbservice [-d dir] [-source dir] [-plugin] [-h] [-v] [[-quiet] |

[-verbose]] { dbconfig } { wsdlurl }

Required argument
The wsdltodbservice command takes one required argument: wsdlurl

specifies the WSDL file from which the database service is generated.

Optional arguments
The wsdltodbservice command takes the following optional arguments:

InterpretationOption

Specifies the output directory for the generated DB service.-d dir

Specifies the output directory for the generated source
code. The default is java.

-source dir

Specifies that the DB service is to be generated as a plug-in
for deployment into an Artix ESB C++ Runtime container.

-plugin

Displays the tool’s usage statement.-h

Displays the tool's version.-v

Specifies that the tool is to run in quiet mode.-quiet

Specifies that the tool is to run in verbose mode.-verbose
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Creating DB Services with Artix Designer
Summary

This chapter explains how to expose a database as a Web service using Artix
Designer.

Table of Contents
Creating a Database Services Project .......................................................................................... 44
Editing the DB Config File ........................................................................................................ 49
Generating WSDL and Code ..................................................................................................... 52
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Creating a Database Services Project
Choosing a runtime

When building anything in Artix Designer The first step is to create a project.
Artix Designer supports projects for building database Web services in both
the Artix ESB Java Runtime, using the JAX-WS specification, and the Artix
ESB C++ Runtime, using JAX-RPC.

Opening the Artix Database
perspective The Artix Database perspective contains all the views and editors that you

need to create and edit a database Web services project.

To open the Artix Database perspective, Select Window → Open Perspective
→ Artix Database.

Creating a project
To create a database Web services project in Artix Designer:

1. Select File → New → Project from the menu bar.

2. In the New Project wizard, expand the Artix folder.

3. Depending on the runtime that you want to use, expand either the
C++/JAX-RPC folder or the Java JAX-WS folder.
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Figure 1. The New Project Wizard

4. Select Database Web Services Project and click Next.

5. In the General Details panel, enter a name for the project and click Next.

6. In the Bookmark Details panel, select a bookmark from the drop-down list
or click New to create a bookmark. See Creating a bookmark.
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7. Click Finish.

Creating a bookmark
In Artix Designer, a bookmark is a saved database connection. You can create
a bookmark from within the New Project wizard or from the Database
Bookmarks view in the Artix Database perspective:

To create a bookmark from the Database Bookmarks view:

1. Ensure that the Artix Database perspective is open. See Opening the Artix
Database perspective.

2. Right-click in the Database Bookmarks view and select New Bookmark.

3. In the New Bookmark wizard, click the Add driver button.

Figure 2. The New Bookmark Wizard

4. In the New JDBC Driver wizard click Add External Jar to select a JAR file
containing the JDBC driver from your file system.
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5. Click Browse to select the driver from the JAR file. The following JDBC
drivers are supported:

• MySQL - com.mysql.jdbc.Driver

• Oracle - oracle.jdbc.driver.OracleDriver

• Sybase - com.sybase.jdbc3.jdbc.SybDriver

6. Click Finish to return to the New Bookmark wizard.

7. Select the newly-added JDBC driver and click Next.

8. In the Connection Details panel, enter the following details:

• The username and password that you use to connect to your DBMS

• The name of the machine hosting the database

• The port number that the database is running on

• The database name
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Figure 3. The Connection Details Panel

9. Click Next.

10. Provide a unique name for the database bookmark and click Finish.
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Editing the DB Config File
Using the DB Config File Editor

The database configuration file is at the heart of all Artix database Web
services. It contains details of the database connection that you wish to expose
as a Web service and it is where you can map SQL queries to WSDL
operations.

Although the format of the DB config file differs depending on whether you
are creating a service for the Artix ESB Java Runtime or the Artix ESB C++
Runtime, you need not worry about this when using Artix Designer. The DB
Config File Editor creates the correct file format depending on which project
type you have created.

As soon as you create a database Web services project, the DB Config File
Editor opens with the Operation tab displayed.
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Figure 4. The DB Config File Editor

Adding SQL statements and
parameters Enter your SQL query in the SQL Statement field. SQL statements must

conform to SQL-92 and JDBC 1.x.

If the query contains a parameter, as in Example 4, “An SQL Query Containing
a Parameter” click the Add button to specify it in the SQL Parameters field.

Example 4. An SQL Query Containing a Parameter
SELECT * from employee_account WHERE name like ?

Specifying stored procedures
If the query that you have entered in the SQL Statement field is a stored
procedure select the Stored Procedure check box. You should enclose the
SQL statement that calls the stored procedure in braces, as shown in
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Example 5. Calling a Stored Procedure
{call get_all}

Testing your query
Once you have completed your query and added all the necessary parameters,
click the Test SQL button. The output is returned to the Result Set tabbed
page of the SQL Results view.

Figure 5. The SQL Results view

Renaming operations
By default any new operations that are added to the DB Config Editor are
called "operation0". To rename an operation to something more meaninful,
right-click the operation in the Outline view and select Rename.

Adding and deleting operations
To add operations to the DB config file, click the icon at the top of the DB
Config Editor.

To delete an operation click the icon.
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Generating WSDL and Code
Overview

Once you have completed the DB config file, you are ready to generate WSDL
and JAX-WS or JAX-WS compliant Java code for your database Web service.

To generate code, click the icon at the top of the DB Config Editor.

JAX-RPC generation options
When generating WSDL and JAX-RPC compliant Java code for the Artix ESB
C++ Runtime, the WSDL/Service Generation Options dialog box includes the
following options:

Generation Type
Select Generate WSDL and service to generate a full WSDL file and the
code needed to run the service. Select Generate logical WSDL only to
generate the logical part of a WSDL contract only. This is the equivalent
of running the dbconfigtowsdl command without the -fasttrack

argument.

SOAP/HTTP Details
You can edit the port and service name in the Endpoint Address field,
as required.

Code Generation Details
Select Service plug-in to generate a service that you can deploy inside
an Artix Container. Select Client/server application to generate a client
application and a server mainline. You can also choose to generate an
Ant build.xml file to manage subsequent builds.
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Figure 6. WSDL/Service Generation Options for a JAX-RPC
Service

JAX-WS generation options
When generating WSDL and JAX-WS compliant Java code for the Artix ESB
Java Runtime, the WSDL/Service Generation Options dialog box includes the
following options:

Generation Type
Select Generate WSDL and service to generate a full WSDL file and the
code needed to run the service. Select Generate logical WSDL only to
generate the logical part of a WSDL contract only. This is the equivalent
of running the dbconfig2wsdl command with the -logical argument.

SOAP/HTTP Details
You can edit the port and service name in the Endpoint Address field,
as required
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Note
When you generate JAX-WS code for a database service, client and
server mainline applications are generated by default.

Figure 7. WSDL/Service Generation Options for a JAX-WS
Service
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